S. C. MCPHERSON JUNIOR HIGH SCHOOL
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SUBJECT: BUSINESS STUDIES
GRADE LEVEL: 8
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DURATION: 1 Hour

STUDENT’S NAME:

TEACHER’S NAME: Place a check mark next to the name of their teacher

Ms. T. Johnson
Mrs. J. Clear
Mrs. N. Sweeting-Uriz

Instructions: This exam includes 3_ sections. Read the instructions and answer all
questions in each section appropriately. The number of points awarded for each section is
included in the instructions before each section.
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SECTION: A
Multiple choice
Total Marks (58)

Instructions: For each question there are four suggested answers —a, b, ¢, and d. To answer to a
question, circle the letter in front of the correct answer. Each question is worth one point.
1. Ergonomics is:
a) s a condition where a tendon becomes inflamed.
b) is an inflammation of the nerve that connects your forearm to the palm of your
hand.
c) the study of work or how people work in their environment.

d) s the term for problems caused by looking at a computer screen.

2. Two types of repetitive strain injury (RSI) are:
a) Carpal tunnel syndrome and Tendinitis.
b) Carpal tunnel and syndrome
c¢) Tendinitis and repetitive strain

d) Computer vision syndrome and Tendinitis

3. Which of the following is not a symptom of computer vision syndrome (CVS)?
a) Eyestrain
b) Headache
c) Tendonitis

d) Blurred vision

4. What is a computer keyboard?
a) An output device that displays information in pictorial form.
b) Contains the main electronics components of a desktop computer
c) Aninput device that allows a person to enter data into a computer.

d) An output device that allows a user to print items on paper.

5. How many keys are on a standard keyboard?
a) 90
b) 100
c) 102
d) 104
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6. To end the current paragraph and begin the next paragraph:
a) press the Escape key once and the Enter key once.
b) press the Enter key twice.
c) press the Home key once and the space bar once.

d) press the Backspace key once.

7. A character can be erased by pressing:
a) the Enter key.
b) the Shift key.
c) the Escape key.
d) the Backspace key.

8. The arrow keys can be used to:
a) delete text.
b) move the cursor within the text without erasing or entering text.
c) save the document.

d) execute commands.

9. The Tab key is used to:
a) moves the cursor over 1 space
b) moves the cursor over 5 spaces
c) adds a space between words

d) delete characters

10. Caps Lock key is a toggle key that:
a) Capitalize all letters
b) Only capitalize one letter
c) Insert symbols

d) Insert a space between letters

11. Shift Key has two functions; they are:
a) select symbols and move the insertion point
b) select symbols only
c) select symbols and indent

d) select symbols and capitalize
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12. Backspace key erases characters to the
a) right of the insertion point
b) It does ease anything
c) left of the insertion point

d) Terminates aline

Answer questions 13 to 28 using the Word window diagram shown below:
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13. The part of the window labelled A is:
a) Title bar
b) Ribbon
c) File tab
d) Status bar

14. The part of the window labelled B is:
a) File tab
b) Title bar
c) Ribbon

d) Quick access toolbar
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15. The part of the window labelled C is:

a) Quick access toolbar
b) Ribbon
¢) Title bar

d) Status bar

16. The part of the window labelled D is:

a) Title bar
b) Help button
c) Quick access toolbar

d) Maximize

17. The part of the window labelled E is:
a) Minimize
b) Ruler
c) Horizontal scroll bar

d) Maximize

18. The part of the window labelled F is:
a) Dialog box launcher
b) Maximize button
c) Help button

d) Minimize button

19. The part of the window labelled G is:
a) Title bar
b) Maximize button
c) Help button
d) Taskbar

20. The part of the window labelled H is:
a) Document area
b) Help button
c) Insertion point/ Cursor

d) Horizontal scroll bar
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21. The part of the window labelled I is:
a) Zoom button

b) Vertical scroll bar

c) Layout view

)
d) Horizontal scroll bar

22. The part of the window labelled J is:
a) Zoom button
b) Document area
c) Dialog box launcher

d) Status bar

23. The part of the window labelled K is:
a) Help
b) Ruler
c) Vertical scroll bar

d) Cursor/Insertion point

24, The part of the window labelled L is:
a) Dialog box launcher
b) Status bar
c) Horizontal scroll bar

d) View buttons

25. The part of the window labelled M is:
a) Status bar
b) Document area
c) Horizontal scroll bar

d) Zoom control

26. The part of the window labelled N is:
a) Zoom button
b) Horizontal scroll bar
c) Layout view

d) Vertical scroll bar
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27. The part of the window labelled O is:
a) Zoom button
b) Document area
c) Layout view

d) Status bar

28. The part of the window labelled P is:
a) Zoom button
b) b) Scroll bar
c¢) Layout view

d) d) Status bar

29. The Status Bar:
a) are used to perform tasks and run programs.
b) display a list of commands.
c) display the information about the document.

d) contains a series of options users select to communicate with an application.

30. To view more options in a group on the Ribbon press:
a) maximize the Ribbon.
b) click the Dialog Box Launcher.
c) double-click a Ribbon tab.

d) customize the Quick Access Toolbar.

31. If the rulers are not visible above and to the left of the document, click:
a) Viewtab
b) Layout tab
c¢) Home tab

d) Review ruler

32. Scroll bar is used to:
a) add text to a document.
b) decrease the length of a page.
c) increase the length of a page.

d) bring into view parts of a document that are off the screen.
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33. Selecting the Zoom command allows you to:
a) open a copy of the document in a different view.
b) print a copy of the displayed document.
c) change the magnification of the displayed document.

d) save a copy of the displayed document.

Answer questions 34 to 38 using the Ribbon diagram shown below:
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34. How many Tabs are on this ribbon?
a) 1
b) 5
c) 7
d) 9

35. How many groups are on this ribbon?
a) 1
b) 2
c) 3
d) 4

36. To displays backstage view press:
a) title bar
b) file tab
c) status bar

d) quick access toolbar

37. A document stored on a storage media is called a:
a) database.
b) file.
c) process document.

d) report.
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38. If a previously saved file is edited:
a) the file must be saved again to retain the changes.
b) the changes will automatically be saved in the file.
c) the file will only have to be saved again if it is more than one page in length.

d) previously saved files may not be edited.

39. Word requires that you name all files saved on the hard drive:
a) to allow letters to be named for people who will receive them.
b) to allow a listing to be made of filenames.
c) toidentify them,

d) Word does not require files to be named.

40. Displays the location where the file will be saved.
a) Navigation pane
b) Folder
c) Address bar

d) Save dialog box

41. Displays folders and locations.
a) Navigation pane
b) Folder
c) Address bar

d) Save dialog box

42. To print a document:
a) select the Print command from the File Tab, then select Print.
b) select the Ready Printer command from the Edit menu and then select Ok.
c) type PRINT and press Enter.
d) close the document, select the Print command from the File Tab, then select

Print.

43, Before printing a document:
a) save the document so that it is not lost if there is a problem with the printer.
b) count the words to make sure they fit on one page.
c) turn off the computer.

d) exit Word.
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44. If Word is not exited properly:
a) files may be damaged or lost.
b) the computer will be damaged.
c¢) the information may be erased.

d) no problems should occur.

45, Closing a file:
a) automatically saves the file.
b) removes the file from the computer’s memory.
¢) sends the file to the printer.

d) renames the file.

46. Word wrap is when:
a) aword is too long to fit on a line and is deleted by Word.
b) Word hyphenates a word at the end of the line.
c) Word determines if there is room for a word at the end of a line or if it should go
on the next line.

d) the typist determines where one line of text ends and the next begins.

47. To create a new document:
a) click on the Word button and then select Ok.
b) type in the filename then select Ok.
c) click New on the File Tab, then Blank Document.

d) click on the cancel button and then start typing.

48. The Show/Hide 9 button:
a) creates a new paragraph.
b) displays or hides symbols for characters like spaces and tabs.
c) displays or hides the Ribbon.

d) displays or hides the text you just typed.

49. To reverse the effects of the last command you executed:
a) select the Reverse/Redo command.
b) select the Back command.
c) select the Undo command.

d) itis not possible to reverse the effects of the last command.
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50. To repeats the effects of the last command you executed:
a) select the Reverse/Redo command.
b) select the Back command.
¢) select the Undo command.

d) it is not possible to reverse the effects of the last command.

51. When the mouse pointer is moved into the Work area, it changes to:
a) anarrow shapes.
b) an L-shape
c) thel-Beam pointer.

d) It does not change.

52. Which of the following formatting marks can be added to a document?
a) Tab mark (=)
b) Space mark (*)
c) Paragraph mark/Enter (1)

d) All of the above marks can be added to a document.

53. Which of the following special characters can be added to a document?
a) @

b) ©

C) ™

d) All of the above characters can be added to a document.

54, Space _____ after a comma.
a) Once
b) Twice
c) Three

d) No space

55. Space __ after a colon.
a) Once
b) Twice
c) Three

d) No space
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56. Space ___ after the period or full-stop.
a) Once
b) Twice
c) Three

d) No space

57. space between the number and the dollar sign $
a) Once
b) Twice
c) Three

d) No space

58. Space ____ before and after the at sign @ in an email address
a) Once
b) Twice
c) Three

d) No space

Total Marks [58]

SECTION: B
True/False Questions
Total Marks (14)

Instructions: Determine if each of the following questions are true or false; please write your
answer in the space provided.

1. Repetitive strain injury that occurs only in computer users.

2. CTS is an injury that occurs in the neck.

3. To prevent eyestrain, you should reduce glare and reflections on your
screen.

4. Bad posture can lead to RSI.

5. Lower back pain is a result of stretching your lower back.

6. Most Windows applications have similar interface.

7. The title bar displays the file name and type of document.

8. Commands are selected from menus in the title bar.
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10.

A7

12.

13.

14.

Press the End key to move the insertion point to the end of a line of text.
Press the Alt key to cancel the current operation.
Answer to History? Is an example of a valid, descriptive file name.

Any changes made to a document after saving are automatically stored in
the file on disk.

A word processor application and a spreadsheet application can be
running at the same time.

Only one Word document can be opened at a time.

Total Marks [58]

SECTION: C
Label Diagrams
Total Marks (14)

Instructions: Label the six (6) parts of the keyboard in the space provided; fill-in the missing
word on the line. (7 points)

]

FIE
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7. What is the name of this keyboard layout? (1pt)

Instructions: Write which finger type each letter (A, D, F, G, J, K, L, S, ;) on the hand diagram in
the space provided. Fill-in the missing letters on the hand diagram. (10 points)
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